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This document contains information about the Fiery Network Controller for 
DocuColor 240/250 version 1.1. Before using the Fiery Network Controller for 
DocuColor 240/250 with version 1.1, make copies of these 

 

Customer Release Notes

 

 and
the 

 

Quick Connect Guide

 

 and distribute them to all users.
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This document uses the term “Fiery” to refer to the Fiery Network Controller for 
DocuColor 240/250. The term “copier” is used to refer to the DocuColor 240/250 copier.

Before printing to the Fiery, make sure that system software version 1.1 is installed on the 
Fiery. To determine this, print a copy of the Configuration page from the copier control panel 
as follows:

 

1 Press the Machine Status button.

2 Touch the Billing Meter/Print Report tab on the touch screen.

3 Touch the Print Report/List option, and then the Network Controller Jobs Report option.

4 Select the System Settings List option.

5 Press the green Start button to print the Configuration page.

 

You must also install user software version 1.1 onto client computers. For instructions, 
see 

 

Printing from Windows

 

 and 

 

Printing from Mac OS

 

.

 

User 
documentation

 

User documentation available online

 

For user documentation in all supported languages, including the 

 

Customer User Addendum

 

, 
see the following website:

 

http://services.efi.com/support/vfigs/9019710383/

 

System software

 

System software installation

 

If you install system software from a client computer over the network, and the installation 
fails because of connection timeout, exit any applications and disable any virus protection 
software or pop-up blocker on the client computer.

 

After installing, upgrading, or reinstalling software

 

After installing

 

, 

 

upgrading, or reinstalling your system software, you must reboot the Fiery.
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User Software CD

 

Color files for Nordic languages

 

The following color files are not included for the Nordic languages (Norwegian, Finnish, 
Swedish, and Danish):

 

Windows English Color Files

 

• CMYK.PS

• PANTONE.PS

• RGB_01.DOC

• RGB_02.PPT

• Custom21.ps

• Custom34.ps

• Stand21.ps

• Stand34.ps

 

 Mac OS English Color Files

 

• CMYK Color Reference.ps

• PANTONE Book.ps

• RGB page 01

• RGB page 02

• custom21.ps

• custom34.ps

• standard21.ps

• standard34.ps
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Setup

 

Server name

 

You cannot assign the server the same name as the device name (DC250). Utilities may 
not function properly. 

 

Fiery device name

 

For both DocuColor 250 and DocuColor 240 copiers, the Fiery device name is DC250. On 
the Configuration page and other Fiery pages, DC250 refers to the device name, which 
applies to both products. Use this device name when starting applications such as Command 
WorkStation and ColorWise Pro Tools.

 

More Setup

 

Similar to WebSetup, More Setup in WebTools lets you set printing defaults, configure 
network services, and perform administration tasks. For some Setup options in WebSetup 
or Command WorkStation, you must set additional options in More Setup. The tabs under 
More Setup are described in 

 

Configuration and Setup,

 

 along with their related Setup options 
or tasks.

If you make changes to the settings in the following areas under More Setup, you must click 
Reboot Server in WebSetup for the changes to take effect: Network Setup 2, SNMP Setup, 
Time Zone, Misc Setup, Optional Features.

 

Point and Print default printer driver

 

You can specify the type of printer driver (PostScript or PCL) that is installed by the Point and 
Print feature in More Setup > Network Setup 1. Before you change this setting, delete all 
printer drivers on client computers first (using the Fiery Printer Delete Utility). Otherwise, 
existing printer drivers on client computers may become corrupted.

 

Changing the time in WebSetup

 

When you change the time and date using the DocuColor 240/250 Tools mode, the change 
applies to the copier only, not the Fiery. To change the time and date on the Fiery, use 
WebSetup. The time on the Fiery is shown in the header of reports such as the Job Log 
and Configuration page. 

 

Cannot disable Web Services

 

You cannot disable Web Services in WebTools. If you disable Web Services and reboot the 
Fiery, Web Services is once again enabled automatically.
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Accessing WebSetup

 

If you are unable to access WebSetup by entering the DNS name of the Fiery in Internet 
Explorer, perform the following steps:

 

1 Start WebSetup by entering the IP address of the Fiery in Internet Explorer.

 

The Accessing WebSetup window appears, displaying instructions for configuring 
Internet Explorer.

 

2 Follow the on-screen instructions. 

 

If the Java Custom Settings button is not visible, scroll to the Microsoft VM area of the 
Custom Level dialog box and select Custom, under Java Permissions.

 

3 Repeat the instructions, but select the Local Intranet zone, instead of Internet. Configure 
the Local Intranet options using the same settings that were used for the Internet zone.

 

FTP Proxy Setup

 

To use the FTP Proxy service, you must first enable FTP Services.

 

Printing from Tray 5 (Bypass Tray) by default

 

To set a default for jobs to use the Bypass Tray, specify the tray at print time in the printer 
driver. There is no Setup option by which the administrator can set a default. 

 

WINS Address

 

The WINS Address does not appear in WebSetup in DHCP mode when you configure 
Network Setup. Print a Configuration page to see the WINS address.

 

WebSetup on Mac OS X

 

To use WebTools on Mac OS X, set the display resolution to 1280

 

x

 

1040 or higher. 
Otherwise, some options in WebSetup may be hidden.

 

Job Log Setup

 

You must enable both Auto Print Job Log After 55 Jobs and Auto Clear Job Log After 
55 Jobs for them to function properly. Disabling either one of them results in both 
features not functioning. 

 

Error History Report

 

The Error History Report shows the error “027-741 Job Template Server Connect Fail” each 
time the Fiery is rebooted. This message is triggered as part of the normal start-up sequence 
and does not indicate an error condition.
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Group Printing

 

If Group Printing (also called Member Printing) is enabled, you cannot download files from 
Downloader, WebDownloader, or Command WorkStation. If Group Printing is enabled, do 
one of the following:

• Print directly from the application in which the file was created.

• Download the file to the Hold queue, change the owner information for the job with 
Command WorkStation, and send the job to print.

 

Printing Groups

 

WebSetup allows you only to enable or disable the use of Printing Groups. To define the 
actual groups, use Command WorkStation. 

 

SNMP limitations

 

If you change the community name or disable SNMP, WebSetup does not work. 
Power off and on the device when you make a change to the SNMP tab in More Setup.

If you disable SNMP, the automatic search for the Fiery feature in Command WorkStation, 
which is based on SNMP, does not work.

If you disable SNMP, the following features are affected:

• Two-Way Communication

• All Fiery applications that search for Fiery controllers using SNMP (Command 
WorkStation, Remote Scan, and Downloader)

• Xerox CentreWare

• Xerox MIBs

 

Login Window for SNMP

 

After you change and save the community name, a Login window appears. To validate the 
changes, enter “Admin” as the User Name and the Administrator password in Command 
WorkStation as the Password.

 

Disabling IPP printing

 

IPP printing version 1.0 (rfc 2566) can use the IPP (port 631) or HTTP (port 80) protocols. 

To disable IPP printing on the Fiery, open WebTools and go to the Service2 tab under 
Network Setup in WebSetup. Clear the IPP printing option.

To disable IPP printing only at port 631, browse the information at this address: 

 

http://<ipaddress>/cgi-bin/ss_cgi/ss.cgi

 

 

and use the Port Blocking feature to block IPP printing port 631. IPP printing at port 80 is 
still enabled in this case.
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OTE

 

: 

 

You can also disable IPP printing by clearing the Fiery Web Services option in Fiery 
Setup. After you reboot the server, Web Services comes back on by default but IPP printing 
stays disabled.

 

Network

 

Ethernet speed

 

The Ethernet speed setting under Network Setup on the copier control panel lists two choices 
that are not supported: 10BASE-TX (Full Duplex) and 100BASE-TX (Full Duplex). It does 
not list a choice for a 1-gigabit speed. Use WebSetup to set the speed to 1 gigabit.

 

PServer does not support IP connection

 

NetWare Printing (PServer) on the Fiery only supports IPX connection, not IP.

 

NDS Setup

 

In Network Setup, to enable both PServer Mode and NDS, first select the Enable PServer 
Mode option, and then wait until the cursor returns to an idle state before you select the 
Enable NDS option.

 

IPX Frame type

 

In WebSetup, under Network Setup, you can select multiple IPX Frame types. However, 
Network Setup on the copier control panel allows you to select only one IPX Frame type, 
and if you have selected multiple types through WebSetup, only one is shown in the copier 
control panel.

 

Changing network settings

 

If you change any network settings in Setup from the copier control panel, the Fiery reboots. 
The Fiery loses connection with the copier until it has finished restarting, which takes a 
minute or two. You can determine whether the connection has been restored by pressing the 
All Services button. If the Network Scanning button is grayed out, the connection has not 
been restored yet.

 

Maximum number of users for SMB

 

The Fiery supports a total of eight simultaneous SMB connections, including the 
Direct connection, Print queue, and Hold queue.

 

Windows 2000 and LPR availability

 

When you perform a clean installation of Windows 2000 on a client computer, no LPR 
services are available by default. Your only option is to print through a standard TCP/IP 
port or use SMB printing. However, if you converted a Windows NT 4.0 computer to 
Windows 2000, LPR printing services are retained.
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Creating an SMB port in Windows 2000/XP

 

To create an SMB port in Windows 2000/XP, you must first establish a connection to the 
Fiery by its IP address. Choose Start and select Run. At the prompt, enter “\\” followed by the 
Fiery IP address, and then click OK. After you make the connection, follow the instructions 
to create an SMB port on Windows 2000/XP.

 

Banner Page on NetWare networks

 

We recommend that you disable the NetWare banner page. Instead, configure the Fiery in 
Setup to use the Cover Page with each job.

 

User name on Cover Page from Netware 

 

The Cover Page displays the complete NetWare context for the user name. 

 

Printer driver

 

Configuring the Windows printer drivers

 

To use the printer driver on Windows 2000/XP/Server 2003, you must first configure the 
options on the Advanced tab of the printer driver after installation is complete. 

 

T

 

O

 

 

 

CONFIGURE

 

 

 

THE

 

 

 

OPTIONS

 

 

 

ON

 

 

 

THE

 

 A

 

DVANCED

 

 

 

TAB

 

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printer and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Click the Fiery icon and choose Properties from the File menu.

3 Click the Advanced tab.

4 Select the following options:

 

• Spool print documents

• Start printing immediately

• Print spooled documents first

 

5 Clear the following option:

 

• Enable advanced printing features.

 

6 Click Apply to save your changes.

7 Click OK.

 

Job Monitor

 

Job Monitor is automatically installed when you install a Windows printer driver. 
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Duplicate Page Size settings

 

In the Windows 2000/XP/Server 2003 printer driver, the Page Size option lists the following 
redundant (duplicated) settings. Either setting in each pair produces the same result.

• Letter and Letter LEF

• Legal and Legal SEF

• Tabloid and 11

 

x

 

17 SEF 

• A3 and A3 SEF

• A4 and A4 LEF

• A5 and A5 LEF

• 9

 

x

 

11 and 9

 

x

 

11 LEF

 

Incorrect information in Windows PostScript driver

 

In the Windows PostScript driver Properties window, in the Features area of the General tab, 
a No is listed next to Double-sided. However, double-sided (duplex) printing is supported.

 

Choosing PPD for Mac OS X printer driver

 

When you configure the Mac OS X printer driver (using the Printer Setup Utility), we 
recommend that you select the printer model (DocuColor 250 PS or DocuColor 240 PS) 
from those listed under Xerox. If you select the model using Other, be sure you browse to the 

 

<Startup disk>:Library:Printers:PPDs:Contents:Resources

 

:

 

<language>.proj

 

 folder to select the 
PPD and not to the folder that contains the installer.

 

Mac OS X and Use Media Defined Profile

 

To set the Output Profile option to Use Media Defined Profile on Mac OS X, you must 
first make sure Two-Way Communication is not enabled, and then select Use Media Defined 
Profile from the drop-down list for Output Profile. Enable Two-Way Communication if you 
need to be able to select specific downloaded output profiles.

 

Mac OS X v10.4 support

 

The OS X Installer, PPD, and PPD plug-ins are all supported by Mac OS X v10.4. 
If you experience difficulty installing the printer driver on Mac OS X v10.4, contact 
Technical Support.
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Booklet Maker on Mac OS X v10.4

 

In the Mac OS X v10.4 printer driver, if the list of Booklet Maker selections is grayed, make 
them selectable by doing the following:

 

1 Set the Duplex option to Top-Top and set Face Down Printing to Face Up.

2 Go to the Summary tab, and then come back to the Printer Features tab.

3 Select the Fasten Mode and Booklet Maker options.

 

For more information about booklet printing on Mac OS X, see the 

 

Customer User 
Addendum

 

.

 

Printer image

 

The printer image in the printer driver does not display properly if it is viewed in 24-bit 
screen resolution. To display the image properly, change the screen setting to 16-bit or 32-bit 
resolution.

 

Group Printing and Saved Settings

 

In the Windows printer drivers, if you save a collection of settings that include Group 
Printing (also called Member Printing) information (such as a printing group name and 
password), assign the Saved Settings a name. Do not leave the Saved Settings as “Untitled.”

 

Windows default settings

 

In the Windows printer driver, if you change the default settings for print options in the 
printer driver, those settings apply to your computer only. To change the default settings for 
all users, change the default settings on the Fiery server.

 

Entering an IP address

 

In the Properties dialog box, pressing Enter after you type an IP address closes the dialog box. 
Press Tab or use the mouse to move between fields, and fill in all options before you press 
Enter or click OK.
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Fiery PPD for 64-bit Windows XP/Server 2003 printer driver

 

The PPD for the 64-bit version of Windows XP or Windows Server 2003 (available on the 
User Software (Drivers) CD) allows you to use the standard Windows printer driver to send 
jobs to the Fiery. You can access the PPD options when you print from an application by 
clicking Advanced in the Printer Properties window. The PPD options are available under 
Printer Features.

Some print options are not available or are only partially functional, including:

• Tray Alignment

• Centering Adjustment

• Scale

• Preview Master

• Print Mode

• Group Name

• Group Password

• Description

• Notes

• Orientation

• Mixed Media Front or Back Cover

• FreeForm

Constraints between two or more settings are indicated with yellow warning icons, but you 
are not prevented from printing a job with settings that conflict.

Two-Way Communication is not available when using this PPD with the standard Windows 
printer driver. You must manually configure the printer driver with any installed options. For 
instructions, see 

 

Printing from Windows

 

.

 

Fasten Mode

 

For a folded and stapled booklet, the maximum number of sheets is 15 (a 60-page booklet). 
For a folded, unstapled booklet, the maximum number of sheets is 5 (a 20-page booklet). 
If your booklet is larger than 60 pages and you choose folding and stapling, the finisher will 
not staple it and will output it in multiple sets of 5 folded sheets.
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Imposition Reduction

 

The Imposition Reduction option is supported in the PostScript printer driver only. For 
booklet printing from the PCL printer driver, Imposition Reduction is always enabled.

 

Centering Adjustment and Creep Adjustment and booklet printing

 

The Centering Adjustment and Creep Adjustment options apply only to booklet printing. 
You must set the Booklet Maker option before you can set these options.

 

Booklet cover single-sided if job is single-sided

 

If Duplex is Off, a cover cannot be printed on the back side, even if you set Front Cover 
or Back Cover to Print on Back or Print on Both. The cover is not printed duplex if the job 
is single-sided.

 

Booklet Output Tray and Cover Page

 

If you print a job to the Booklet Output Tray, the job does not print with a cover page, 
regardless of the Cover Page setting.

 

Booklet Maker not supported on Mac OS 9

 

The Booklet Maker option and related options, such as Fasten Mode, are not supported 
on Mac OS 9.

 

Booklet Maker not supported for printing to Direct connection

 

To use the Booklet Maker option, you must print to the Print queue or Hold queue. The 
Booklet Maker option is not supported for printing to the Direct connection.

 

Cannot print secure PDF file as booklet (PostScript printer driver)

 

If a PDF file requires a password to edit, printing it as a booklet from the PostScript printer 
driver results in an error. Print from the Windows PCL printer driver instead.
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Print options

 

Image Shift not available from applications

 

The print options related to Image Shift are not available in the Print dialog box of the 
application you print from. You must set these options in the Fiery Printing tab.

 

Printer Screen Mode and color objects

 

If you set the Printer Screen Mode option to Enhanced Text & Graphics or Enhanced Text, 
you might see a color difference between text, graphics, and image objects. If this occurs, set 
the Printer Screen Mode option to 200 Cluster Dot or 200 Rotated Line instead.

 

Printer Screen Mode and large text

 

If a document contains text in a large font size, set the Printer Screen Mode to Enhanced Text 
& Graphics, 200 Cluster Dot, or 200 Rotated Line instead of Enhanced Text. This ensures 
that the same screen is applied to small text objects and large text objects.

 

Black Overprint and uneven color

 

If you use the default setting for the Black Overprint option, which is Text/Graphics, 
you might see uneven color in some jobs. If this occurs, set the Black Overprint option to 
Off instead.

 

CMYK Simulation Method and color gradation

 

If you find that color gradations are not printed smoothly, try setting the CMYK Simulation 
Method to Full (Source GCR).

 

CMYK Simulation Profile and black-and-white bitmapped TIFF images

 

If black-and-white bitmapped TIFF images appear overtoned and embossed when printed, 
change the CMYK Simulation Profile from the default setting of ISO Coated to SWOP.

 

Combine Separations

 

If you select the Combine Separations option, the job is printed single-sided and face down, 
regardless of how the Duplex and Face-Down Printing options are set.

 

Layout option and line widths

 

If you print with the Layout option set to any setting besides 1-up, some line widths may vary.

 

Print options not supported on Direct connection

 

The following print options are not supported when printing to the Direct connection, only 
when printing to the Print queue or Hold queue: Collate, Booklet Maker, Fasten Mode, Print 
Size, Stapler Mode, Face-Down Printing, Create Master, Use Master, Print Master, Remove 
White PPT Background. 

The Save Fast Reprint option is supported only when printing to the Print queue.
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Manual Duplex

 

If you print using Manual Duplex from Tray 5 (Bypass), when you are prompted to load 
paper for Side 2, you must first empty the tray and then reload it with the Side 2 media.

If you print using Manual Duplex from Tray 6 (Oversized), you are prompted to change 
paper for Side 2. You must load the Side 2 media in the tray, but you do not have to empty 
the tray first unless the Side 2 media will not fit otherwise. After you close the tray, you might 
be prompted to press Start to change the tray’s media type setting. After you press Start, the 
job continues printing.

If you press Start before opening the tray and loading the Side 2 media, the prompt may 
disappear. If this happens, open the tray and load the Side 2 media. You might be prompted 
to press Start to continue printing.

 

Mixed page sizes and Manual Duplex not supported

 

Printing jobs that have mixed page sizes using the Manual Duplex option is not supported.

Mixed Media and collation

To collate a job when you print using Mixed Media settings, do not set the Collate option 
in your application’s Print dialog box. Instead, set the Collate option in the Fiery Printing tab.

Mixed Media, Duplex, and Orientation

For a Mixed Media job in which some pages are oriented Portrait and others are oriented 
Landscape, duplex pages might not print with the correct orientation. 

Mixed Media covers from Tray 5 (Bypass)

If you print a PDF document with the PostScript printer driver and use the Mixed Media 
option to add front and back covers printed from Tray 5 (Bypass), only the front cover prints 
from Tray 5 (Bypass).
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Mixed Media covers from Tray 5 (Bypass) with duplex jobs

A duplex job that uses Mixed Media settings to specify a cover printed from Tray 5 (Bypass) 
does not print correctly if the cover Media Type set is set to Use Machine Settings and the 
copier setting for Tray 5 (Bypass) media type is Heavyweight 2. Because of the Heavyweight 2 
media, the job is forced to print in reverse order and face up. However, duplex pages cannot 
be printed on Heavyweight 2 media, so Plain media is used instead. Plain media does not 
force face up printing, so the job prints with the default Face Down setting. The result is that 
the job prints in reverse order face down, and the output pages are out of order.

If Tray 5 Media Protection is enabled and the copier setting for Tray 5 (Bypass) is not 
Heavyweight 2, Tray 5 Media Protection forces the cover pages to print as if for Heavyweight 
2. Since Heavyweight 2 media cannot be printed duplex or stapled, the covers will print 
single-sided and not stapled, regardless of the job settings.

To avoid these types of interactions, select a specific Media Type for the job. Do not leave the 
setting as Use Machine Settings.

Media Type selections grayed (Windows)

In the Windows printer drivers, a Media Type setting appears dimmed if there are other print 
options selected that would be in conflict with that Media Type setting. You can still select a 
dimmed setting, and you can have the printer driver resolve the conflict automatically.

Media Type and Tray 6 (Oversized)

Printing a job with Media Type set to Tab Stock 1 or Tab Stock 2 is not supported when 
printing from Tray 6 (Oversized). Use Tray 5 (Bypass) to print with Tab Stock 1 or Tab Stock 
2. For printing thick media from Tray 6 (Oversized), set the Media Type to Heavyweight 1, 
Heavyweight 2, Coated 1, or Coated 2.

Face-Down Printing and custom page size

If you print to a custom page size and set the Face-Down Printing option to Face Down, the 
page dimensions must be within the following ranges, otherwise the job is printed Face Up:

• Width: 139.7 to 330 mm

• Length: 182 to 488 mm

Paper size

When you send a job from an application that allows you to specify paper size in the 
Print dialog box (such as Microsoft Word), select the same paper size in both the application’s 
Page Setup dialog box and the printer’s Properties dialog box.

Before printing your job, verify that the paper size selection in Document Setup and 
Page Setup are the same. This will resolve problems with the printed output, such as 
image clipping and unintentional scaling.
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Custom page size (Windows)

When you specify a custom page size in the Windows printer drivers, make sure that the 
custom size matches the page size specified in your application. If the page sizes do not match, 
the custom page size may not print correctly.

You can print to a custom page size from Tray 1, Tray 2, or Tray 5 (Bypass). For Tray 1 or 
Tray 2, set the page dimensions at the copier under Setup>Paper Tray Attributes. If the 
document that you want to print has a page size of 220x297 mm, for example, set x=220 
and y=297. For Tray 5 (Bypass), load the paper so that the short end of the page feeds into the 
copier. Note that the message that prompts you to load paper has the dimensions reversed 
(297x220 instead of 220x297). 

All custom page sizes sent to the DocuColor 240/250 must be created SEF (Short Edge Feed). 

Custom page size (Mac OS X v10.2.8)

When you print from the Mac OS X v10.2.8 printer driver using a custom page size, the 
custom page can have a maximum width of 33 cm and a maximum height of 48.8 cm. If you 
specify a page size that exceeds either or both of these limits, the page size is not accepted and 
the job is set to print with the default page size. To use a page size that exceeds the maximum 
width or height allowed by the printer driver, print the job to the Hold queue and set the page 
size using Command WorkStation.

Custom page size and Tray 6 (Oversized) on Mac OS X

When you print from Mac OS X using a custom page size, set up the page size as follows to 
enable the Fiery to display the correct page size in messages: 

1 Open the file and choose Page Setup from the application’s File menu.

2 For Settings, choose Page Attributes. For Format for, choose the Fiery.

3 For Paper Size, choose Manage Custom Page Sizes. 

4 Enter the specifications for the custom page size and click OK.

5 Click OK to close Page Setup.

6 Choose Print from the application’s File menu.

7 Choose the Fiery as your printer.

8 Choose Paper Handling from the drop-down list, select Scale to Fit Paper Size, and choose the 
custom page size you created. 

9 Choose Paper Feed from the drop-down list, select All Pages From, and choose Tray 6 
(Oversized).

10 Click Print.
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Paper Source set to Auto Select

If you print a job with Auto Select as the paper source, the copier uses any of the Trays 1- 4, 
or Tray 6. It does not use Tray 5, which is the Bypass Tray.

Page Range

You cannot access the Page Range option from the printer driver. Use the application page 
range option or change the setting for this option from Command WorkStation or Spooler.

Watermarks, Negative Image, and Print Page Borders

The Negative Image print option is not available in Windows printer drivers. The 
Watermarks and Print Page Borders print options are not available in Windows PostScript 
printer drivers.

These print options are available under Page Setup in Mac OS 9 and Mac OS X Classic.

Layout and Print Page Borders

If you print an N-up job, where N is greater than 1, from the PCL printer driver, you can 
control whether the borders of the pages are printed, through the Print Page Borders option. 
If you print from the PostScript printer driver, page borders are always printed.

Stapler Mode and Punch Position

Stapling and punching require that a finisher is installed on the copier. The finisher type 
determines the number of holes (2, 3, or 4) punched. 

Use the Punch Position print option to specify the position of punching. Use the Stapler 
Mode print option to specify the number (1 or 2) and position of staples. 

Neither stapling nor punching are supported for the following page sizes:

4x6 SEF, 5x7 SEF, A5 SEF, A5 LEF, B5 SEF, 12x18 SEF, SRA3 SEF, 13x19 SEF

To see which stapling and punching options are available for each supported page size, see 
the following tables.
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For no Hole Punch (Punch Position set to None):

S = Stapling supported
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S S - -

A4 SEF - S S S S - - S S

A4 LEF - S S S S S S - -

Letter SEF - S S S S - - S S

Letter LEF - S S S S S S - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF - S S S S - - S S

A3 SEF - S S S S - - S S

11x17 SEF - S S S S - - S S

Letter Cover 
LEF

- S S S S S S - -

A4 Cover LEF - S S S S S S - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S S

A4 SEF - S S S S S S - -

A4 LEF - S S S S - - S S

Letter SEF - S S S S S S - -

Letter LEF - S S S S - - S S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF - S S S S S S - -

A3 SEF - S S S S S S - -

11x17 SEF - S S S S S S - -

Letter Cover 
LEF

- S S S S - - S S

A4 Cover LEF - S S S S - - S S
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For 2 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S, P(l) S, P(r) - -

A4 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Legal SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

B4 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S,P(t) S

A4 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Legal SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

B4 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

A3 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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For 3 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S, P(l) S, P(r) - -

A4 SEF - S S S S - - S S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF - S S S S - - S S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF P(t) S S S S - - S, P(t) S

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S,P(t) S

A4 SEF - S S S S S S - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF - S S S S S S - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF P(l,r) S S S S S,P(l) S,P(r) - -

A3 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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For 4 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S S - -

A4 SEF - S S S S - - S S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF - S S S S - - S S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF - P(t) - - - - - - -

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S S

A4 SEF - S S S S S S - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF - S S S S S S - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF P(l.r) - - - - - - - -

A3 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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Printing Job status information

When you make photocopies on the copier, information about the job is displayed. 
The same kinds of information, however, are not displayed while the Fiery is printing 
a job. To determine information about a job sent to the Fiery, print the Job Log, or 
view the job with the job management tools (Command WorkStation and Spooler).

Out-of-paper message when Paper Source set to AutoSelect

If you set the Paper Source option to AutoSelect, the Fiery selects the tray to print from 
according to its priority list. If a tray runs out of paper in the middle of a job, the Fiery 
requests that you load paper in the first tray on its priority list, but you can load paper 
in any tray that supports the paper size needed.

No out-of-toner message on copier while printing

If a toner needs to be replaced while a job is printing, a message appears in Command 
WorkStation, but the copier does not display a message until it is finished printing. 
You can replace toner while the copier is printing.

Incomplete printout with I/O error

When you print from a Windows PostScript driver, if your job does not finish and an 
Error page prints that indicates “ioerror,” try reprinting the job with the PostScript output 
format set to PostScript (optimized for portability - ADSC) rather than PostScript (optimized 
for speed). 

TO SET THE POSTSCRIPT OUTPUT FORMAT

1 Print the job from the application, select the Fiery as the printer, and click Properties. 

2 Click the PostScript tab.

3 Choose PostScript (optimized for portability - ADSC) under PostScript Output Format. 

In this format, each page of the document is sent as a self-contained, independent page 
description.

Novell systems

If you print a job with Novell, the PCL Separator Page does not work.

Suspend Printing message

If you suspend printing, Command WorkStation and the Fiery do not display the copier as 
offline immediately. The printer offline message is not displayed until the copier has finished 
printing that portion of the job.
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Date and time stamps for jobs

You can print the following reports:

• Job Status

• Scan Mode Settings

• Copy Mode Settings

• Network Controller Jobs Report

All jobs in Job Status, Scan Mode Settings, and Copy Mode Settings use the date and time 
on the copier.

You can print the following reports from Network Controller Jobs Report:

• Job History Report

• Error History Report

• Fonts List

• System Settings List

The Job History Report, Fonts List, and System Settings List use the date and time on the 
Fiery. The Error History Report uses the date and time on the copier (except for error codes 
from the Fiery).

Job batching

If job batching is enabled, multiple jobs received by the Fiery close together are printed as a 
single job. You can control job batching through the Job Batching Delay option under More 
Setup in WebTools. If this option is set to 0, job batching is disabled. If this option is set to a 
nonzero value, jobs that are received within this number of seconds are batched.

If job batching is enabled:

• The job information displayed on the copier for batched jobs is not correct, because the 
jobs are considered one job. Command WorkStation and the Job Log show the correct 
information for the individual jobs.

• After printing has completed, the job status remains Printing until the Job Batching Delay 
has expired.

• Color jobs are not batched with grayscale or black-and-white jobs. 

• Jobs with the Save Fast Reprint option selected and jobs printed through the Print and 
Hold command in Command WorkStation are not batched. They are always printed as 
individual jobs.
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E-mail printing SMTP services

You must enable SMTP services on your network’s e-mail server.

Group Printing

E-mail printing is not supported with Group Printing (also called Member Printing) enabled.

E-mail account password

E-mail printing does not work if the Fiery e-mail account does not have a password. 
To receive e-mail print jobs, you must set a password for the e-mail account that the Fiery 
is configured to use.

Supported file attachments

The supported file attachments for e-mail printing are PostScript, PRN (Windows printer 
file), PDF (version 1.5), and TIFF (version 6).

JPEG and Microsoft Office documents are not supported as attachments. 

TIFF documents

If you print a TIFF file through e-mail, by attaching the file to an e-mail message sent to 
the Fiery, and the TIFF file was compressed using G3MH or G4MMR, the file is printed 
correctly but no e-mail notifications are sent.

When you send a TIFF document to the Fiery as an e-mail attachment, no cover page 
is printed.

USB printing Printing files using a USB drive

Users can save printable files to the optional USB drive and print those files on the Fiery. To 
print files automatically when you connect the USB drive to the Fiery, save the files to specific 
folders on the USB drive.

TO SET UP THE USB DRIVE AND PRINT FILES

1 Create folders at the top level (root level) of the USB drive for each print connection (Print, 
Hold, and Direct) that you want to use.

Use the Print queue to print a job and retain it for possible reprinting. Use the Hold queue to 
hold a job on the server for modification and printing later. Use the Direct connection to 
print a job without retaining it.

2 Name the folders as follows: Print for the Print queue, Hold for the Hold queue, and Direct for 
the Direct connection.
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3 Copy the file(s) (PS, EPS, PCL, TIFF, and PDF) from the user’s computer to the folder on the 
USB drive that corresponds to the print connection to use for the file(s).

4 Remove the USB drive from the user’s computer and connect it to the USB port on the Fiery.

Files are downloaded to the corresponding print connection on the Fiery automatically when 
you connect the USB drive to the Fiery. For information about enabling print connections, 
see Configuration and Setup.

Scanning TWAIN plug-in does not support mixed page size jobs

The Remote Scan TWAIN plug-in does not support transferring mixed original size scan 
jobs to applications such as Adobe Photoshop. However, the Remote Scan application 
supports retrieving mixed scan jobs from mailboxes and distributing these jobs through 
e-mail or saving them to a local hard disk. 

Supported applications

The following applications support the TWAIN plug-in: Adobe Photoshop versions 5.5 and 
6.0 for Mac OS and Windows, and Adobe Acrobat version 6.0 for Mac OS and Windows.

Initiating a scan job

Initiating a scan job remotely is not supported. You can, however, retrieve and distribute scan 
jobs. To initiate a scan, you must use the interface on the copier.

Cannot change Mailbox/Job Template Name in Edit Mode

When you select Edit mode for an existing Mailbox/Job Template on the copier, you cannot 
change the name of the Mailbox/Job Template, but you can change any of the Mailbox/Job 
Template settings, such as Color Mode or Scan Size.

Duplex scanning

The Remote Scan application and TWAIN plug-in provide an option to select double-sided 
or single-sided to retrieve a scan. This option does not have any effect. The Mailbox/Job 
Template used for the scan job specifies whether the scan is double-sided or singled-sided.

Acrobat 7.0 not supported

The Remote Scan TWAIN plug-in is supported in Acrobat 6.0, but not in Acrobat 7.0. 
You can also use Remote Scan and WebScan to retrieve scans.

Default Mailboxes/Job Templates

The following default Mailboxes/Job Templates are predefined on the copier: (ColorCal), 
(InternetFax), (color), (bw), (grayscale).
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InternetFax Mailbox/Job Template

When you select the InternetFax Mailbox/Job Template from the copier control panel, the 
document is always scanned at 200 dpi, even if you select a higher resolution. Internet Fax 
transfers low resolution data only.

Mailbox/Job Template naming

When you retrieve a scan using Remote Scan or WebScan, for the default templates (color), 
(bw), and (grayscale), enter 0 as the mailbox name. For the (InternetFax) template, enter 
InternetFax as the mailbox name. Default templates have no passwords (leave blank).

When you create a Mailbox/Job Template, use only uppercase letters (A-Z) and numerals 
(0-9). When you retrieve a scan using a user-defined template, enter the name, using only 
uppercase letters and numerals. If you enter the name using lowercase letters, you can log on 
to the mailbox, but cannot view any scan jobs. 

Mailbox/Job Template display order

The default templates are always listed before any user-defined templates. User-defined 
templates are listed in ASCII order. If you add a new user-defined template, any templates 
listed after it are renumbered.

Scan to FTP not supported for all FTP servers

Scan to FTP is not supported for all FTP servers. If an FTP server does not reply to a NLST 
command with a 4xx or 5xx response, scan to FTP from the Fiery does not work correctly. 
The WS_FTP server is known to have this issue.

FTP passwords not saved on export

When you export mailbox settings in the Mailbox Utility, Scan to FTP passwords are not 
saved. After importing the mailbox settings back to the server, you must input FTP passwords 
with Mailbox Utility again. We recommend that you perform validation after entering FTP 
passwords.

Check Scanner message

If a message appears in Command WorkStation that says to “check scanner power and cable,” 
check the link light on the crossover cable connecting the Fiery to the copier. If it is not lit 
(green), try replacing the cable.
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Supported formats

The following table shows the supported formats for scanning:

WebTools Exiting WebTools

Closing the window for an individual WebTool does not exit the browser. To exit WebTools 
completely, close the WebTools window and your browser.

Scan Color Mode

Color Grayscale Black-and-White

JPEG Single Page Supported Supported Not supported

Entire Job Not supported in 
WebScan. In Remote 
Scan, you can generate 
multiple JPEG files, 
each of a single page.

Not supported in 
WebScan. In Remote 
Scan, you can generate 
multiple JPEG files, 
each of a single page.

Not supported

TIFF Single Page Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file format.

Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file format.

Supported

Entire Job Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file 
format, but only 
shows one page.

Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file format, 
but only shows one 
page.

Generates a single 
multiple page TIFF file.

PDF Single Page Supported Supported Supported

Entire Job Generates a single 
multiple page PDF file.

Generates a single 
multiple page PDF file.

Generates a single 
multiple page PDF file.
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Command 
WorkStation

Job Size

Command WorkStation displays job size in kilobytes, regardless of the size of the file. 
Other tools may show job size in megabytes or kilobytes.

Job Log

Save and clear the Job Log regularly. After the Job Log accumulates a large number of 
entries (approximately 16,000 jobs), the Fiery stops responding when you start Command 
WorkStation.

Activity Monitor

When you print more than one copy of a job, the Activity Monitor reports that Copy 2 
is printing, and then Copy 2, Copy 3, Copy 4, and so on. Although the Activity Monitor 
does not start counting with Copy 1, the correct number of copies prints.

Available memory

The General Info section displays the amount of memory available for Command 
WorkStation and other Fiery software, whereas the Configuration page displays the amount 
of memory available for Command WorkStation, other Fiery software, and the Fiery system 
software.

The “Memory 100%” displayed in the upper-right corner of the copier display is the copier 
memory. The memory bar in Command WorkStation is the Fiery memory.

Combine Separations

If you send a job with Combine Separations set to On, you may see an error message 
in Command WorkStation. To avoid the error message, set Combine Separations to 
Printer’s default or Off, or send a Separations job.

Image Shift units in Job Properties

When the Job Properties format is set to Simple Table Style Format, you cannot select the 
units for the Image Shift settings. The units are always 1/100 of a point. To select the units 
(mm, inches or points), change the Job Properties format (in Preferences) to Driver Overrides 
Format.

Offset values not in Impose template

When you save a template in Impose, the X and Y offset values are not saved.

File formats for downloading

You can import or download only files of the following formats to the Fiery using Command 
WorkStation, Downloader, or WebDownloader: PostScript (PS), EPS, TIFF, PDF, PCL, PJL, 
and text. Downloading files of unsupported formats results in an error message or an unusable 
printout.
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Incorrect display for FrameMaker jobs

When you print a job with multiple copies from Adobe FrameMaker, the number of copies 
shown in Command WorkStation on Windows platforms is incorrectly displayed as 1.

Printing job properties for PCL jobs

To print the job properties for a job sent using the PCL printer driver, set the Job Properties 
format under Preferences to Driver Overrides Format, instead of Simple Table Style Format.

Recovering jobs after server interruption

If the Fiery is shut down, any job in the Print queue that has been RIPped but not printed is 
sent to the Hold queue. Any job that has not yet been RIPped remains in the Print queue.

Profile selections not updated on Mac OS X

On Mac OS X, if you download a profile using ColorWise Pro Tools, the new profile does not 
appear as a selection in the job properties in Command WorkStation, Macintosh Edition 
unless you quit and restart Command WorkStation, Macintosh Edition. Alternatively, you 
can use Command WorkStation on Windows to select the new profile, because on Windows, 
Command WorkStation uses Two-Way Communication to get the new profile setting.

Tab Shift option on Mac OS

If you view a job’s properties in Command WorkStation, Macintosh Edition, the Tab Shift 
option is listed. However, overriding the setting of this option from Command WorkStation, 
Macintosh Edition, is not supported.

Tray Alignment not supported on Mac OS

The Tray Alignment feature is not supported in Command WorkStation, Macintosh Edition. 
Tray Alignment is supported in Command WorkStation, Windows Edition.

Custom page size not supported on Mac OS

Creating a custom page size is not supported in Command WorkStation, Macintosh Edition. 
You can use the printer driver to specify a custom page size for a job.

Menu selections incorrectly enabled for processing job

In Command WorkStation, Macintosh Edition, you can select Print and Hold or Print for a 
job that is already being processed. These menu selections should be disabled.
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Merging jobs with duplex printing

In Spooler, if you merge two jobs that have duplex printing, the orientation of each page 
in the job cannot be changed because you are merging the raster data. However, the page 
orientation that is correct for the individual jobs may not be correct for the merged job. 
Therefore, you might need to reorient one or more pages before merging the jobs. 

If the jobs use an LEF page size and you want the merged job to print Top-Top, make sure 
both of the original jobs are printed Top-Top. If the jobs use an SEF page size and you want 
the merged job to print Top-Top, set Top-Top in both jobs and set the Rotate 180 option for 
the second job.

Downloader and 
WebDownloader

Downloading PDF or TIFF files

WebDownloader and Downloader do not support sending a PDF or TIFF file to the Direct 
connection. The file is sent to the Print queue instead, or to the Hold queue if the Print queue 
is not enabled.

Downloading fonts

Before downloading fonts, clear the Group Printing (also called Member Printing) option.

Drag and drop

When you use the drag-and-drop method to print a file, Downloader functions slightly 
differently on Mac OS than it does on Windows. On Mac OS, when a file is dropped onto 
the Downloader icon, the Status window appears and remains displayed, even after the file 
is printed. On Windows, the Status window appears and then closes when the job finishes 
printing.

Adding files

In the Files to be Downloaded dialog box, you must either double-click the file or highlight 
the file and click Add Files. You cannot drop a file onto the Files to be Downloaded 
dialog box.

If an error occurs when adding a file to the download list, try the following:

• Make sure the file is closed. A file that is open for viewing cannot be added to the 
download list.

• If you are using Windows, start Windows Explorer and choose Folder Options from the 
Tools menu. Click the View tab, clear “Hide file extensions for known file types,” and 
click OK.

File formats

Downloader supports only EPS, PDF (version 1.5), or PS formats for printing to the Fiery.
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Downloading PDF files with mixed page sizes or orientations

When you download PDF files that contain more than one page size or orientation, the file 
may not print correctly. To print the file, open it in Adobe Acrobat and print using the printer 
driver.

Downloading EPS files

You must select Show EPS Files to download EPS files.

Downloading 16-bit TIFF Files

Downloader is unable to download 16-bit TIFF files to the Fiery.

File types

When you browse files from WebDownloader, WebDownloader does not determine the 
default file type or the file type listed in the File dialog box. The default file type is predefined 
by your Internet browser. If you send HTML files to the printer, the data is printed as ASCII 
text (the default extension for ASCII text is “.txt”). 

When you download PDF files from a Windows computer, the file name and user name are 
displayed as “Unknown.”

ColorWise Pro Tools Color defaults

To set defaults for color printing options, use Color Setup in ColorWise Pro Tools. 
The exception is Color Mode, which cannot be set in Color Setup, nor in Setup from 
Command WorkStation or WebSetup. However, you can set the color mode for a job at 
print time when you print from the printer driver.

PANTONE spot color tints

If the rendering of some PANTONE spot color tints does not match the expected spot color, 
install the 1-LQ6D7 patch. You can obtain this patch using Software Updates in WebTools.

ColorCal

Make sure that the Original Orientation option on the copier is set to Head to Top and 
that the ColorCal patch pages are positioned Head to Top on the copier platen.

When you print measurement pages for ColorCal, an instruction page also prints. To ensure 
good results after calibration, follow these instructions.

NOTE: There is currently no way to print only the measurement pages without the instruction 
page.
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Calibration using the ES-1000

In ColorWise Pro Tools, if you calibrate the Fiery using an ES-1000 spectrophotometer with 
Random patches selected, but the patch page you use actually contains Sorted patches, 
Calibrator does not notify you of your error. To reset the system to the proper color state, reset 
all color settings to their defaults.

Calibrating before Start Page is printed 

Allow the Start Page to print before performing calibration. This ensures that the Fiery has 
fully completed its startup process.

Profile Manager not supported on Mac OS 9

In ColorWise Pro Tools on Mac OS 9, the Profile Manager is not supported.

Applications Adobe PageMaker and Booklet Maker

The Booklet Maker option is not supported for printing from Adobe PageMaker.

Adobe InDesign and Booklet Maker

If you print from Adobe InDesign CS v2.0 or v2.5 on Windows XP, the Booklet Maker 
option is not supported using the PostScript printer driver. Use the PCL printer driver 
instead.

NOTE: Booklet Maker is supported when printing from InDesign v1.5 on Windows and 
InDesign v3.0 on Mac OS.

Adobe InDesign and Mirror

Printing from Adobe InDesign using the Mirror option is not supported. If you print from 
InDesign with this setting enabled, the job is printed without the setting enabled.

Adobe Acrobat and Mixed Media

If you print a document in Adobe Acrobat on Windows and use the Mixed Media print 
option in the printer driver to insert a blank page before or after the last page, the page is not 
inserted. To insert a blank page before or after the last page, download the document to the 
Hold queue and insert the page using the Mixed Media feature of Command WorkStation.

Adobe Acrobat and PCL printer driver

If you print a PDF document from Adobe Acrobat using the PCL printer driver, an 
embedded text box might be printed as a black box. To avoid this problem, print using the 
Windows PostScript printer driver or download the PDF file to the Fiery using Command 
WorkStation.
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Microsoft Excel and PCL printer driver

If you print from Microsoft Excel using the PCL printer driver, and the document contains 
bold characters in a font that does not have a separately defined bold font, set the following 
options in the PCL printer driver on the Fonts tab: 

• Select Auto Match

• Select Outlines under Font downloading

Microsoft Excel and multiple copies

If you print multiple copies of a file from Microsoft Excel, all the pages are combined into a 
single copy. Therefore, if the job is stapled, all the pages are stapled together, and if the job is 
printed as a booklet, all the pages are combined into one booklet. If duplex printing is 
enabled, the first page of one copy might print on the back side of the last page of the previous 
copy.

To print multiple copies from Microsoft Excel, print to a file, and then download the file 
using Downloader or Command WorkStation.

If you want collated copies, you must clear the Collate option in Microsoft Excel (in the Print 
dialog box) and select the Collate option on the Fiery Printing tab.

Microsoft Excel and Hole Punching

If you want to select Hole Punching for a Microsoft Excel document, make sure the 
document orientation is Portrait. The default orientation of an Excel document is Landscape, 
but Hole Punching is not supported with Landscape orientation in Excel.

Visio 2003 and PCL printer driver

If you print from Visio 2003 using the PCL printer driver, select “Always use host fonts” on 
the Fonts tab of the printer driver.

Adobe Freehand

To print from Adobe Freehand on Windows, use the PostScript printer driver rather than the 
PCL printer driver.

Collation

To collate a job when you print from Microsoft Word, do not set the Collate option in the 
Print dialog box. Instead, set the Collate option on the Fiery Printing tab.

To collate a job when you print from CorelDRAW or Microsoft Internet Explorer version 5 
or 5.5, use the Collate option in the printer driver in addition to the Collate option within 
the application.
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Landscape duplex

When you print a landscape job as duplex, some applications, such as Adobe PageMaker 
and Adobe Acrobat 4, produce Top-Top output when you select Top-Bottom, and vice versa. 
For Acrobat 5 jobs, select the Auto Rotation option for duplex printing.

Booklet printing in Microsoft Word

If you print a document as a booklet from Microsoft Word, you must set the page size in the 
application (in Page Setup) and the page size on the Fiery Printing tab to the same setting. For 
more information, see the Customer User Addendum.

Graphics in Microsoft Word

If a Microsoft Word document contains a graphic object with a white background, and the 
background prints as black instead of white when you print the document using the PCL 
printer driver, select the object in Microsoft Word and change the background from No Fill to 
White.

Printing to a custom page size in Microsoft Word

Use the following procedures to print to a custom page size from Microsoft Word 2000, 
2002, XP, or Server 2003. There are two ways to specify the custom page size: using forms and 
not using forms.

TO PRINT TO A CUSTOM PAGE SIZE USING FORMS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Click the Fiery icon and choose Server Properties from the File menu.

The Print Server Properties window appears.

3 On the Forms tab, select Create a New Form.

4 Under Measurements, enter the Width and Height of the custom page size.

5 Next to Form Description for, enter a name for the form that indicates the page size.

6 Click Save Form and click OK.

7 Open the document to be printed in Microsoft Word.

8 Choose Page Setup from the File menu and click the Paper Size tab.

9 Choose Custom size from the Paper size drop-down list.

Do not select the form you created.

10 Enter the same Width and Height values that you used to create the form and click OK.

11 Choose Print from the File menu.

12 Select the Fiery as the printer and click Properties.
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13 Click the Paper/Quality tab and click Advanced.

14 Next to Paper Size, select the form that you created and click OK.

15 Click the Fiery Printing tab and check that the Page Size setting (under the Paper Source bar) 
is set to the custom page size.

16 Select the Paper Source.

17 Click OK to close the Properties window.

18 Click OK to print.

TO PRINT TO A CUSTOM PAGE SIZE WITHOUT USING FORMS

1 Open the document to be printed in Microsoft Word.

2 Choose Page Setup from the File menu and click the Paper Size tab.

3 Choose PostScript Custom Page Size from the Paper size drop-down list.

4 Enter Width and Height values of the custom page size and click OK.

5 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

6 Click the Fiery icon and choose Printing Preferences from the File menu.

7 Click the Paper/Quality tab and click Advanced.

8 Next to Paper Size, choose PostScript Custom Page Size.

9 Enter the same Width and Height values as before and click OK.

10 Click OK to close the Advanced Options window.

11 Click the Fiery Printing tab, check that the Page Size setting (under the Paper Source bar) is 
set to PostScript Custom Page Size, and click OK.

12 In Microsoft Word, choose Print from the File menu.

13 In the drop-down list next to Scale to Paper Size, select PostScript Custom Page Size.

14 Select the Fiery as the printer, and then click OK to print the document.
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Microsoft PowerPoint 2003 on Windows 2000

When you print from Microsoft PowerPoint 2003 on Windows 2000, you might see repeated 
images or images that are reduced in one dimension in the printed output. The output prints 
correctly if you print from Windows XP or from PowerPoint 2000.

Preview on Mac OS X

If you print a PDF document using Preview on Mac OS X v10.4, the job name might be 
different from the name of the PDF file. If you print the same document using Preview on 
Mac OS X v10.3 or Adobe Acrobat, the job name is the same as the file name.

Online help Help files

The help files for the Fiery utilities are developed for use with Microsoft Internet Explorer 
v5.5 or later. If you use other browsers, such as Safari, or previous versions of Internet 
Explorer, the help may not display properly.

With Microsoft Internet Explorer on a Windows XP Service Pack 2 computer, the help 
files may not display or may not display properly, as in the following situations:

• If your browser uses a pop-up blocker, it may block the help files. If this happens, 
temporarily disable your pop-up blocker to display the help file.

• If your browser has the advanced Internet option enabled to display notifications about 
script errors, it may display a warning window before displaying a help file page. To avoid 
the warning window, clear the “Display a notification about every script error” option on 
the Advanced tab in the Internet Options dialog box.

A warning message may also appear in the Status bar, but the content of the help file is not 
affected by this error.
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